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Question Number : 1 Question Id : 2549896971 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Cache and main memory will lose their contents when the power of a computer is off. This property is referred to as ______.
Options :
1.  dynamic
2.  static
3.  volatility
4.  non-volatile
   



Question Number : 1 Question Id : 2549896971 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
कै श और मु� मेमोरी अपनी सामग्री (कं टे�) खो देंगे जब बिजली बंद हो जाएगी, इस गुण को ___________ के  �प में संदर्भित किया जाता हैं।
Options :
1.  डायनमिक
2.  स्टैटिक
3.  वोलैटिलिटी
4.  नॉन-वोलेटाइल
   
Question Number : 2 Question Id : 2549897516 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is a set of instructions embedded on a piece of hardware at the time of manufacturing  and tells the device how to operate?
Options :
1.  Application Software
2.  Utility Software
3.  Firmware
4.  Freeware
   
Question Number : 2 Question Id : 2549897516 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
नि�लिखित में से कौन सा हार्डवेयर के  निर्माण के  समय उस पर सन्निहित निर्देशों का एक सेट है और डिवाइस को संचालित करने का तरीका बताता है?
Options :
1.  एप्लिके शन सॉ�वेयर (Application Software)

2.  यूटिलिटी सॉ�वेयर (Utility Software)

3.  फर्मवेयर (Firmware)

4.  फ्रीवेयर (Freeware)
   



Question Number : 3 Question Id : 2549897593 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
______________ is a programmable device that takes in input, performs some arithmetic and logical operations over it and produces the desired output.
Options :
1.  SMPS
2.  UPS
3.  Microprocessor
4.  Bus
   
Question Number : 3 Question Id : 2549897593 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
______________ एक प्रोग्राम करने यो� डिवाइस है जो इनपुट लेता है, उस पर कु छ अंकगणितीय और तार्कि क ऑपरेशन करता है और वांछित आउटपुट उ�� करता
है।
Options :
1.  एसएमपीएस (SMPS)

2.  यूपीएस (UPS)

3.  माइक्रोप्रोसेसर (Microprocessor)

4.  बस (Bus)
   
Question Number : 4 Question Id : 2549898331 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
You CANNOT save an MS-Excel 2016 file in a/an _______ format.
Options :
1.  PDF
2.  PSD
3.  TXT
4.  XML
   



Question Number : 4 Question Id : 2549898331 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
आप MS-Excel 2016 फाइल को _____ फ़ॉर्मेट में सेव नहीं  कर सकते।
Options :
1.  PDF
2.  PSD
3.  TXT
4.  XML
   
Question Number : 5 Question Id : 2549898733 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What does the term SCSI stand for?
Options :
1.  Small Computer Software Interface
2.  Small Computer Storage Interface
3.  Small Computer System Interface
4.  Small Computer Standard Interface
   
Question Number : 5 Question Id : 2549898733 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
SCSI का पूर्ण �प __________ हैI
Options :
1.  Small Computer Software Interface (स्मॉल कं प्यूटर सॉ�वेयर इंटरफ़े स)

2.  Small Computer Storage Interface (स्मॉल कं प्यूटर स्टोरेज इंटरफ़े स)

3.  Small Computer System Interface (स्मॉल कं प्यूटर सि�म इंटरफ़े स)

4.  Small Computer Standard Interface (स्मॉल कं प्यूटर स्टै�र्ड इंटरफ़े स)
   



Question Number : 6 Question Id : 25498911553 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The most common input devices are:
Options :
1.  microphone and printer
2.  scanner and monitor
3.  digital camera and speaker
4.  keyboard and mouse
   
Question Number : 6 Question Id : 25498911553 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
इनमे से सबसे आम इनपुट डिवाइस कौन-सी हैं?
Options :
1.  माइक्रोफोन और प्रिंटर
2.  स्कै नर और मॉनीटर
3.  डिजिटल कै मरा और स्पीकर
4.  कीबोर्ड और माउस
   
Question Number : 7 Question Id : 25498911590 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In a computer, which device is functionally opposite to a keyboard?
Options :
1.  Joystick
2.  Track ball
3.  Mouse
4.  Printer
   



Question Number : 7 Question Id : 25498911590 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एक कं प्यूटर में, कौन-सा डिवाइस कार्या�क �प से कीबोर्ड से विपरीत है?
Options :
1.  जॉयस्टिक
2.  ट्रे क बॉल
3.  माउस
4.  प्रिंटर
   
Question Number : 8 Question Id : 25498922571 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is Python language editor?
Options :
1.  Tally
2.  Coda
3.  Jupyter
4.  SnapTouch
   
Question Number : 8 Question Id : 25498922571 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
इनमें से कौन पायथन भाषा संपादक है?
Options :
1.  टैली (Tally)

2.  कोडा (Coda)

3.  जुपिटर (Jupyter)

4.  स्नैपटच (SnapTouch)
   



Question Number : 9 Question Id : 25498929865 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is utility software?
Options :
1.  Avast Antivirus
2.  BIOS
3.  Android
4.  MS-Word
   
Question Number : 9 Question Id : 25498929865 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
नि�लिखित में से कौनसा यूटिलिटी सॉ�वेयर है?
Options :
1.  एवा� एं टीवायरस (Avast Antivirus)
2.  BIOS

3.  एं ड्रॉ इड (Android)
4.  MS-Word
   
Question Number : 10 Question Id : 25498930315 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is true with reference to DVD?
Options :
1.  Full form of  DVD is Digital Valid Disk.
2.  DVDs are not portable.
3.  DVD-R offers a write once  approach.
4.  DVD ROM is used for both reading and writing.
   



Question Number : 10 Question Id : 25498930315 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
DVD के  संदर्भ में नि�लिखित में से कौन सा स� है?
Options :
1.  DVD का पूर्ण �प डिजिटल वैलिड डि� है
2.  DVD पोर्टेबल नहीं  हैं
3.  DVD-R एक बार लिखने का तरीका �दान करता है
4.  DVD ROM पढ़ने और लिखने दोनों के  लिए उपयोग किया जाता है
   
Question Number : 11 Question Id : 25498930727 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is an example of open source software?
Options :
1.  Netflix
2.  MySQL
3.  McAfee
4.  Google Chrome
   
Question Number : 11 Question Id : 25498930727 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
नि�लिखित में से कौन सा ओपन सोर्स सॉ�वेयर का एक उदाहरण है?
Options :
1.  नेटफ्लि� (Netflix)
2.  MySQL

3.  मैकएफी (McAfee)

4.  गूगल क्रोम (Google Chrome)
   



Question Number : 12 Question Id : 25498930903 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following plotters draws exact vector graphics on paper or other media?
Options :
1.  Cutting Plotter
2.  Pinch Roller
3.  Cycle Plotter
4.  Drum Plotter
   
Question Number : 12 Question Id : 25498930903 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
नि�लिखित में से कौन सा प्लॉटर कागज़ या अ� मीडिया पर सटीक वे�र ग्राफ़ि� बनाता है?
Options :
1.  कटिंग प्लॉटर (Cutting Plotter)

2.  पिंच रोलर (Pinch Roller)

3.  साइकिल प्लॉटर (Cycle Plotter)

4.  ड्र म प्लॉटर (Drum Plotter)
   
Question Number : 13 Question Id : 25498930926 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
___________ is an internet service consisting of thousands of newsgroups.
Options :
1.  USECASE
2.  USENET
3.  USESET
4.  UCENET
   



Question Number : 13 Question Id : 25498930926 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
___________ एक इंटरनेट सेवा है जिसमें हजारों समाचार समूह शामिल हैं।
Options :
1.  USECASE
2.  USENET
3.  USESET
4.  UCENET
   
Question Number : 14 Question Id : 25498931017 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following keyboard shortcut keys is used to rename a highlighted icon, file or folder in Windows 10?
Options :
1.  F3
2.  F5
3.  F2
4.  F4
   
Question Number : 14 Question Id : 25498931017 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Windows 10 में हाइलाइट किए गए आइकन, फाइल या फो�र का नाम बदलने के  लिए नि� में से किस कीबोर्ड शॉर्टकट कुं जी का उपयोग किया जाता है?
Options :
1.  F3
2.  F5
3.  F2
4.  F4
   



Question Number : 15 Question Id : 25498931064 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Cortana is an intelligent personal assistant developed by ____________.
Options :
1.  Microsoft
2.  Apple
3.  HP
4.  Oracle
   
Question Number : 15 Question Id : 25498931064 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
कॉर्टाना (Cortana) ____________ द्वारा विकसित एक बुद्धिमान �क्तिगत सहायक है।
Options :
1.  माइक्रोसॉ� (Microsoft)

2.  ए�ल (Apple)

3.  एचपी (HP)

4.  ओरेकल (Oracle)
   
Question Number : 16 Question Id : 2549899002 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following devices is commonly used to protect an internal network from unwanted access?
Options :
1.  Firewall
2.  Router
3.  Switch
4.  Hub
   



Question Number : 16 Question Id : 2549899002 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
अवांछित पहुंच (एक्सेस) से आंतरिक नेटवर्क  की सुरक्षा के  लिए आमतौर पर कौन-सा डिवाइस उपयोग किया जाता है?
Options :
1.  फ़ायरवॉल
2.  राउटर
3.  स्विच
4.  हब
   
Question Number : 17 Question Id : 25498911238 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following statements is/are true?

(i) The actions in a GUI are usually performed through direct manipulation of graphical elements like buttons and icons.
(ii) A type of window that displays additional information and asks a user for input is called 'dialogue box'.
Options :
1.  Only (i)
2.  Only (ii)
3.  Both (i) and (ii)
4.  Neither (i) nor (ii)
   



Question Number : 17 Question Id : 25498911238 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
नि�लिखित में से कौन-सा कथन स� है/हैं?

(i) GUI में क्रियाएं  आमतौर पर बटन और आइकन जैसे ग्राफिकल तत्वों के  सीधे हेरफे र (manipulation) के  मा�म से की जाती हैं।
(ii) एक �कार का विंडो जो अतिरि� जानकारी �दर्शित करता है और उपयोगकर्ता से इनपुट मांगता है उसे 'डायलॉग बॉ� (dialogue box)' कहा जाता है।
Options :
1.  के वल (i)

2.  के वल (ii)

3.  (i) और (ii) दोनों
4.  न तो (i) और न ही (ii)
   
Question Number : 18 Question Id : 25498913578 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
A grey scale picture in JPEG is divided into blocks of ______ pixels.
Options :
1.  6 × 6
2.  5 × 5
3.  7 × 7
4.  8 × 8
   
Question Number : 18 Question Id : 25498913578 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
JPEG में एक ग्रे स्के ल चि�, _____ पि�ल के  ब्लॉक में विभाजित होती है।
Options :
1.  6 × 6
2.  5 × 5
3.  7 × 7
4.  8 × 8



   
Question Number : 19 Question Id : 25498913588 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following ranges across countries and continents?
(i) LAN (ii) MAN (iii) WAN
Options :
1.  Only (i)
2.  Only (ii)
3.  Only (iii)
4.  Both (i) and (ii)
   
Question Number : 19 Question Id : 25498913588 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
नि�लिखित में से किसकी रेंज देश और महाद्वीपों तक होती है?
(i) LAN (ii) MAN (iii) WAN
Options :
1.  के वल (i)

2.  के वल (ii)

3.  के वल (iii)

4.  (i) और (ii) दोनों
   
Question Number : 20 Question Id : 25498913633 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The security property which defines the ability of a system to ensure that an asset is modified only by authorised parties is called __________.
Options :
1.  availability
2.  confidentiality
3.  integrity
4.  cryptograph



   
Question Number : 20 Question Id : 25498913633 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
सुरक्षा संपत्ति जो यह सुनिश्चित करने के  लिए एक �णाली की �मता को परिभाषित करती है कि एक संपत्ति के वल अधिकृ त पार्टियों द्वारा संशोधित की जाती है, उसे
__________ कहा जाता है।
Options :
1.  उपल�ता (availability)

2.  गोपनीयता (confidentiality)

3.  अखंडता (integrity)

4.  क्रिप्टोग्राफ (cryptograph)
   
Question Number : 21 Question Id : 25498919413 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
How to view the MAC address associated with Windows 10 Ethernet device?
Options :
1.  Settings->Network and Internet->Status->View hardware and connection properties
2.  Settings->Dial-up->Properties
3.  Settings->VPN->Properties
4.  Settings->Proxy->Properties
   
Question Number : 21 Question Id : 25498919413 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Windows 10 ईथरनेट डिवाइस से जुड़े MAC पते को कै से देखें?
Options :
1.  Settings->Network and Internet->Status->Properties
2.  Settings->Dial-up->Properties
3.  Settings->VPN->Properties
4.  Settings->Proxy->Properties
   



Question Number : 22 Question Id : 25498922023 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
AES symmetric encryption algorithm performs all its computations on ________ of data rather than in bits.
Options :
1.  bytes
2.  numbers
3.  cells
4.  digits
   
Question Number : 22 Question Id : 25498922023 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एईएस (AES) सममित एन्क्रि�शन एल्गोरि�म बिट्स के  बजाय डेटा के  ________ पर अपनी सभी गणना करता है।
Options :
1.  बाइट्स
2.  नंबर
3.  से�
4.  डिजिट्स
   
Question Number : 23 Question Id : 25498922603 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
When a router needs to send a packet to another computer/network, then it should know which of the following?
Options :
1.  Datagram
2.  Path name
3.  Transport medium
4.  IP address
   



Question Number : 23 Question Id : 25498922603 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
जब किसी राउटर को एक पैके ट को दू सरे  कं प्यूटर/नेटवर्क  में भेजने की आव�कता होती है, तो उसे नि�लिखित में से क्या पता होना चाहिए?
Options :
1.  डेटाग्राम
2.  पथ नाम (पाथ नेम)

3.  परिवहन मा�म
4.  IP एड्रे स
   
Question Number : 24 Question Id : 25498922709 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Sometimes after encountering certain problems with the computer monitor and reporting these problems to the technology coordinator, we need to tell him
the size of the monitor. How is the monitor size measured?
Options :
1.  From left top to left bottom
2.  From right top to right bottom
3.  From corner to corner diagonally
4.  From left top to right top
   
Question Number : 24 Question Id : 25498922709 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
कभी-कभी मॉनिटर की समस्याओं का सामना करने के  दौरान और इन समस्याओं को प्रौद्योगिकी सम�यक को रिपोर्ट करते समय, हमे उन्हें मॉनीटर का आकार (माप)
बताने की आव�कता होती है। मॉनिटर का आकार (माप) कै से मापा जाता है?
Options :
1.  बाएं  शीर्ष से बाएं  तल तक
2.  दायें शीर्ष से दायें तल तक
3.  कोने से कोने तक (तिरछे  �प से)
4.  बाएं  शीर्ष से दाएं  शीर्ष तक
   



Question Number : 25 Question Id : 25498924463 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
A/an ___________ is a weakness in an information system, system security procedures, internal controls or implementation that could be exploited or
triggered by a threat source.
Options :
1.  threat
2.  vulnerability
3.  control
4.  attack
   
Question Number : 25 Question Id : 25498924463 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
____________ एक सूचना �णाली, सि�म सुरक्षा �क्रियाओं, आंतरिक नियं�ण या कार्या�यन में एक कमजोरी है जिसका खतरा स्रोत द्वारा शोषण या ट्रि गर किया जा
सकता है।
Options :
1.  थ्रेट (threat)

2.  व�नेरे बिलिटी (vulnerability)

3.  कं ट्रो ल (control)

4.  अटैक (attack)
   
Question Number : 26 Question Id : 25498924509 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following file formats is used for Java Server Page?
Options :
1.  .js
2.  .java
3.  .jsp
4.  .jspl
   



Question Number : 26 Question Id : 25498924509 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
जावा सर्वर पेज (Java Server Page) के  लिए नि�लिखित में से किस फाइल फॉर्मेट का उपयोग किया जाता है?
Options :
1.  .js
2.  .java
3.  .jsp
4.  .jspl
   
Question Number : 27 Question Id : 25498924603 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
File format WPD is used for which of the following files?
Options :
1.  Image File
2.  Compressed Archive File
3.  Winamp Playlist
4.  WordPerfect Document File
   
Question Number : 27 Question Id : 25498924603 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
फाइल फॉर्मेट WPD का उपयोग नि�लिखित में से किस फाइल के  लिए किया जाता है?
Options :
1.  इमेज फाइल
2.  कम्प्रे�ड आर्काइव फाइल
3.  विनॅ� प्लेलि�
4.  वर्डपर्फे � डॉक्यूमेंट फाइल
   



Question Number : 28 Question Id : 25498925389 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What is the full form of UPS?
Options :
1.  Uninterruptible power supply
2.  Unified power supply
3.  Uninterruptible power sink
4.  Universal power sink
   
Question Number : 28 Question Id : 25498925389 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
यूपीएस (UPS) का पूर्ण �प क्या है?
Options :
1.  Uninterruptible power supply (अनइंटरप्टिबल पॉवर सप्लाई)

2.  Unified power supply (यूनिफाइड पॉवर सप्लाई)

3.  Uninterruptible power sink (अनइंटरप्टिबल पॉवर सिंक)

4.  Universal power sink (यूनिवर्सल पॉवर सिंक)
   
Question Number : 29 Question Id : 25498938501 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is included along with genuine software, and may come from a malicious website or may have been added to the intentional
functionality of genuine software?
Options :
1.  Spyware
2.  VMware
3.  Middleware
4.  Adware
   



Question Number : 29 Question Id : 25498938501 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
इनमें से किसे, सही (वा�विक) सॉ�टवेयर के  साथ शामिल किया जाता है और यह किसी मैलिसियस वेबसाइट से आया हो सकता है या फिर इसे किसी वा�विक
सॉ�टवेयर की इन्टेंशनल कार्यविधि के  लिए जोड़ा जा सकता है?
Options :
1.  स्पाईवेयर
2.  वीएमवेयर (VMware)

3.  मिडलवेयर
4.  एडवेयर (Adware)
   
Question Number : 30 Question Id : 25498940615 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is NOT a benefit of Software Testing?
Options :
1.  Bug free application
2.  Cost effective
3.  Low failure
4.  Gathering requirements
   
Question Number : 30 Question Id : 25498940615 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
नि�लिखित में से कौन-सा, सॉ�वेयर परी�ण का लाभ नहीं  है?
Options :
1.  बग मु� एप्लीके शन
2.  लागत �भावी
3.  कम विफलता
4.  आव�कताओं को इकट्ठा करना
   



Question Number : 31 Question Id : 2549897031 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is NOT a valid email prefix format?
Options :
1.  xyz-d@mail.com
2.  xyz.mnp@mail.com
3.  xyz-@mail.com
4.  xyz@mail.com
   
Question Number : 31 Question Id : 2549897031 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
नि�लिखित में से कौन सा वैध ईमेल उपसर्ग प्रा�प नहीं  है?
Options :
1.  xyz-d@mail.com
2.  xyz.mnp@mail.com
3.  xyz-@mail.com
4.  xyz@mail.com
   
Question Number : 32 Question Id : 2549899028 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
With reference to computer networks, what is the full form of OSI?
Options :
1.  Open Systems Interconnection
2.  Open Source Interconnection
3.  Open Systems Internet
4.  Open Static Interconnection
   



Question Number : 32 Question Id : 2549899028 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
कं प्यूटर नेटवर्क  के  संदर्भ में, OSI का पूर्ण �प क्या है?
Options :
1.  Open Systems Interconnection (ओपन सि�� इंटरकने�न)

2.  Open Source Interconnection (ओपन सोर्स इंटरकने�न)

3.  Open Systems Internet (ओपन सि�� इंटरनेट)

4.  Open Static Interconnection (ओपन स्टैटिक इंटरकने�न)
   
Question Number : 33 Question Id : 2549899078 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
________  is unsolicited internet content that is typically sent in bulk for advertising purposes from an unknown sender.
Options :
1.  Spam
2.  Cookies
3.  Firewall
4.  Phishing
   
Question Number : 33 Question Id : 2549899078 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
________ एसी अवांछित इंटरनेट सामग्री (कं टे�) है जो आम तौर पर किसी अज्ञात प्रेषक से विज्ञापन उद्देश्यों के  लिए थोक (ब�) में भेजी जाती है।
Options :
1.  स्पैम
2.  कु कीज़
3.  फ़ायरवॉल
4.  फ़िशिंग
   



Question Number : 34 Question Id : 25498912512 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
When you are inserting a page number in the footer of an MS-Word 2019 document, the number 2 appears, however, you want the letter b to be shown.

How will you do that?
Options :
1.  From the Insert tab choose page number and specify necessary setting
2.  Go to the Layout tab and click on the page number format tool and then page margin
3.  From the Format menu choose bullets & numbering
4.  Go to the Mailings tab and specify required setting
   
Question Number : 34 Question Id : 25498912512 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
जब आप MS-Word 2019 डॉक्युमेंट के  फु टर में कोई पेज नंबर इ�र्ट करते हैं, तो नंबर 2 दिखाई देता है, लेकिन आप अ�र b दिखाना चाहते हैं।

आप यह कै से करेंगे?
Options :
1.  इ�र्ट टैब से पेज नंबर चुनें और आव�क सेटिंग निर्दि� करें
2.  लेआउट टैब पर जाए और पेज नंबर फॉर्मेट टू ल पर क्लिक करें  और फिर पेज मार्जिन पर क्लिक करें
3.  फॉर्मेट मेनू से बुलेट और नंबरिंग चुनें
4.  मेलिंग टैब पर जाए और आव�क सेटिंग निर्दि� करें
   
Question Number : 35 Question Id : 25498913345 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In MS-Word 2019, the space between tabs can show dots, dashes etc. These are called _________.
Options :
1.  decimal characters
2.  space characters
3.  leader characters
4.  extra characters



   
Question Number : 35 Question Id : 25498913345 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Word 2019 में, टैब के  बीच का स्थान डॉट्स, डैश आदि दिखा सकता है। इन्हें _________ कहा जाता है।
Options :
1.  डेसीमल कै रे�र्स
2.  स्पेस कै रे�र्स
3.  लीडर कै रे�र्स
4.  एक्स्ट्रा  कै रे�र्स
   
Question Number : 36 Question Id : 25498919185 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In a network, __________ measures the time it takes for some data to get to its destination across the network. It is a measure of delay.
Options :
1.  network latency
2.  bandwidth
3.  frequency
4.  wavelength
   
Question Number : 36 Question Id : 25498919185 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
नेटवर्क  में, __________ , कु छ डेटा को नेटवर्क  से होकर अपने गंत� तक पहुंचने में लगने वाले समय को मापता है। यह विलंब का माप होता है।
Options :
1.  नेटवर्क  लेटेंसी
2.  बैंडविड्थ
3.  फ्रिक्वें सी
4.  वेवले�
   



Question Number : 37 Question Id : 25498919216 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is NOT a valid option for setting up type of letters in the second step of the Mail Merge process in MS-Word 2019?
Options :
1.  Use the current document
2.  Start from a template
3.  Start from existing document
4.  Start using current document
   
Question Number : 37 Question Id : 25498919216 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Word 2019 में मेल मर्ज �क्रिया के  दू सरे  चरण में लेटर्स के  �कार को सेट करने के  लिए नि� में से कौन-सा एक वैध विक� नहीं  है?
Options :
1.  वर्तमान डॉक्यूमेंट का इस्तेमाल करें  (Use the current document)

2.  एक टे�लेट से शु� करें  (Start from a template)

3.  मौजूदा डॉक्यूमेंट से शु� करें  (Start from existing document)

4.  वर्तमान डॉक्यूमेंट का उपयोग करके  शु� करें  (Start using current document)
   
Question Number : 38 Question Id : 25498919229 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
There is/are ______ radio button(s) under Select Starting Document for letters in the second step of the Mail Merge process in MS-Word 2019.
Options :
1.  one
2.  two
3.  three
4.  four
   



Question Number : 38 Question Id : 25498919229 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Word 2019 में मेल मर्ज �क्रिया के  दू सरे  चरण में पत्रों के  लिए "Select Starting Document" के  अंतर्गत ______ रे डियो बटन होता है/होते हैं।
Options :
1.  एक
2.  दो
3.  तीन
4.  चार
   
Question Number : 39 Question Id : 25498920588 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is NOT a search engine?
Options :
1.  Microsoft Bing
2.  Google.com
3.  Coursera
4.  Yahoo.com
   
Question Number : 39 Question Id : 25498920588 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
इनमें से कौन-सा, एक सर्च इंजन नहीं  है?
Options :
1.  Microsoft Bing
2.  Google.com
3.  Coursera
4.  Yahoo.com
   



Question Number : 40 Question Id : 25498925244 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is an address that identifies a process on a host?
Options :
1.  IP address
2.  Port number
3.  Network address
4.  MAC address
   
Question Number : 40 Question Id : 25498925244 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
नि�लिखित में से कौन-सा, एक एड्रे स है जो किसी हो� पर एक प्रोसेस की पहचान करता है?
Options :
1.  IP एड्रे स
2.  पोर्ट नंबर
3.  नेटवर्क  एड्रे स
4.  मैक एड्रे स
   
Question Number : 41 Question Id : 25498925495 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In MS-Word 2019, to save a document using the quick access toolbar if the Save button is NOT available in the quick access tool bar, which of the
following must be done?
Options :
1.  Go to File -> Drag open option to quick access toolbar -> Save document
2.  Double-click on quick access toolbar
3.  Click down arrow on right side of quick access toolbar -> Click Save and the Save option is added to quick access toolbar
4.  Go to File -> Save -> Go to quick access toolbar
   



Question Number : 41 Question Id : 25498925495 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Word 2019 में, क्विक एक्सेस टू लबार का उपयोग करके  किसी डॉक्युमेंट को सेव करने के  लिए यदि क्विक एक्सेस टू ल बार में सेव बटन उपल� नहीं  है, तो नि� में से
क्या किया जाना चाहिए?
Options :
1.  क्लिक करें  File -> ओपन ऑपशन को ड्रे ग करके  क्विक एक्सेस टू ल बार पर ले जाए -> डॉक्युमेंट सेव करें
2.  क्विक एक्सेस टू ल बार पर डबल क्लिक करें
3.  क्विक एक्सेस टू ल बार के  दाईं ओर डाउन एरो पर क्लिक करें  -> Save क्लिक करें  -> डॉक्यूमेंट सेव करें
4.  क्लिक करें  File -> Save -> क्विक एक्सेस टू ल बार पर जाए
   
Question Number : 42 Question Id : 25498933799 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
A _______ is a device that converts digital computer signals into an analog signal form that can travel over phone lines. It also re-converts the analog signals
back into digital signals.
Options :
1.  router
2.  hub
3.  modem
4.  codec
   
Question Number : 42 Question Id : 25498933799 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
__________, एक उपकरण है जो डिजिटल कं प्यूटर सि�ल को एक एनालॉग सि�ल �प में परिवर्तित करता है जो फोन लाइनों पर यात्रा कर सकता है। यह एनालॉग
सि�लों को वापस डिजिटल सि�ल में भी परिवर्तित करता है।
Options :
1.  राउटर
2.  हब
3.  मॉडेम
4.  कोडेक



   
Question Number : 43 Question Id : 25498938414 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which Ethernet Cable is made of glass cores surrounded by several layers of covering material generally made of PVC or Teflon?
Options :
1.  Twisted pair cable
2.  Coaxial cable
3.  Fibre optic cable
4.  Unshielded twisted pair
   
Question Number : 43 Question Id : 25498938414 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
कौन सी ईथरनेट के बल ग्लास कोर से बनी होती है जो आमतौर पर पीवीसी या टेफ्लॉन से बने आवरण सामग्री की कई परतों से घिरी होती है?
Options :
1.  ट्विस्टेड पेयर के बल
2.  कोएक्सिअल के बल
3.  फाइबर ऑप्टिस के बल
4.  अनशील्डेड ट्विस्टेड पेअर
   
Question Number : 44 Question Id : 25498942495 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
To create a graph in MS-Excel 2019, which of the following steps must be taken?
Options :
1.  File tab -> Charts
2.  Home tab -> Charts
3.  Insert tab -> Recommended Charts
4.  View tab -> Charts
   



Question Number : 44 Question Id : 25498942495 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Excel 2019 में ग्राफ बनाने के  लिए नि�लिखित में से किन चरणों का उपयोग किया जाता है?
Options :
1.  फ़ाइल टैब -> चार्ट (File tab -> Charts)

2.  होम टैब -> चार्ट (Home tab -> Charts)

3.  इ�र्ट टैब -> रिकमेंडेड चार्ट (Insert tab -> Recommended Charts)

4.  व्यू टैब -> चार्ट (View tab -> Charts)
   
Question Number : 45 Question Id : 25498942499 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
A chart ________ is a brief, descriptive label that summarizes the main point or purpose of the graph.
Options :
1.  axes
2.  title
3.  source
4.  legend
   
Question Number : 45 Question Id : 25498942499 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
चार्ट ________ एक संक्षि�, वर्णना�क लेबल है जो ग्राफ के  मु� बिंदु या उद्दे� को सारांशित करता है।
Options :
1.  एक्सेस (Axes)

2.  टाइटल (Title)

3.  सोर्स (Source)

4.  लीजेंड (Legend)
   



Question Number : 46 Question Id : 25498942515 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following keyboard shortcuts is used to make letters italic in MS-Excel 2019?
Options :
1.  Ctrl + I
2.  Ctrl + B
3.  Ctrl + U
4.  Ctrl + V
   
Question Number : 46 Question Id : 25498942515 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Excel 2019 में अ�रों को इटैलिक करने के  लिए नि�लिखित में से किस कीबोर्ड शॉर्टकट कुं जी का उपयोग किया जाता है?
Options :
1.  Ctrl + I
2.  Ctrl + B
3.  Ctrl + U
4.  Ctrl + V
   
Question Number : 47 Question Id : 25498942519 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following keyboard shortcuts is used to hide a row in MS-Excel 2019?
Options :
1.  Ctrl + 9
2.  Ctrl + 0
3.  Ctrl + 1
4.  Ctrl + 2
   



Question Number : 47 Question Id : 25498942519 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Excel 2019 में एक पंक्ति को छिपाने के  लिए नि�लिखित में से किस कीबोर्ड शॉर्टकट का उपयोग किया जाता है?
Options :
1.  Ctrl + 9
2.  Ctrl + 0
3.  Ctrl + 1
4.  Ctrl + 2
   
Question Number : 48 Question Id : 25498942540 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
A sports competition consisting of various sports was held for the students of a school. A sports teacher recorded the scores of all students in MS-Excel
2019. He now wants to find the total scores of the students across all sports. Which of the following functions should he use?
Options :
1.  COUNT
2.  ADD
3.  SUM
4.  TOTAL
   
Question Number : 48 Question Id : 25498942540 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एक स्कू ल के  छात्रों के  लिए विभि� खेलों की एक खेल �तियोगिता आयोजित की गई। एक खेल शि�क ने MS-Excel 2019 में सभी छात्रों के  अंक दर्ज किए। अब वह सभी
खेलों में विद्यार्थियों के  कु ल अंक ज्ञात करना चाहता है। उसे नि�लिखित में से किस फं �न का उपयोग करना चाहिए?
Options :
1.  COUNT
2.  ADD
3.  SUM
4.  TOTAL
   



Question Number : 49 Question Id : 25498942544 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
A teacher has entered the marks of 30 students in her subject. Now, she wants to arrange them in ascending order. Which of the following options within the
Data tab in MS-Excel 2019 should the teacher use?
Options :
1.  Sort
2.  Format
3.  Filter
4.  Design
   
Question Number : 49 Question Id : 25498942544 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एक शिक्षिका ने अपने विषय में 30 विद्यार्थियों के  अंक दर्ज किए हैं। अब, वह इसे आरोही �म में �वस्थित करना चाहती है। शिक्षिका को MS-Excel 2019 में डेटा टैब के
अंतर्गत नि�लिखित में से किस विक� का उपयोग करना चाहिए?
Options :
1.  सॉर्ट (Sort)

2.  फॉर्मेट (format)

3.  फ़ि�र (filter)

4.  डिजाइन (design)
   
Question Number : 50 Question Id : 25498942560 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
After appearing for an exam, Sirish got his results for six different subjects. He wants to find his average. Which of the following functions of MS-Excel
2019 should he use?
Options :
1.  Avg
2.  Average
3.  Mean
4.  Mode



   
Question Number : 50 Question Id : 25498942560 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एक परीक्षा में बैठने के  बाद, सिरीश ने छह अलग-अलग विषयों के  लिए अपना परिणाम प्रा� किया। वह अपना औसत ज्ञात करना चाहता है। उसे MS-Excel 2019 के
नि�लिखित में से किस फ़ं �न का उपयोग करना चाहिए?
Options :
1.  Avg
2.  Average
3.  Mean
4.  Mode
   
Question Number : 51 Question Id : 25498942564 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is included along with genuine software, and may come from a malicious website or may have been added to the intentional
functionality of genuine software?
Options :
1.  Spyware
2.  VMware
3.  Middleware
4.  Adware
   



Question Number : 51 Question Id : 25498942564 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
नि�लिखित में से कौन-सा वा�विक सॉ�टवेयर के  साथ शामिल हो सकता है, और किसी दुर्भावनापूर्ण वेबसाइट से आ सकता है या वा�विक सॉ�टवेयर की जानबूझकर
की गई कार्य�मता में जोड़ा गया हो सकता है?
Options :
1.  स्पायवेयर
2.  वीएमवेयर
3.  मिडलवेयर
4.  एडवेयर
   
Question Number : 52 Question Id : 25498942565 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following keyboard shortcuts is used to select an entire column in MS-Excel 2019?
Options :
1.  Ctrl + Spacebar
2.  Alt + Spacebar
3.  Shift + Spacebar
4.  Spacebar
   
Question Number : 52 Question Id : 25498942565 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
MS-Excel 2019 में संपूर्ण कॉलम का चयन करने के  लिए नि�लिखित में से किस कीबोर्ड शॉर्टकट कुं जी का उपयोग किया जाता है?
Options :
1.  Ctrl + Spacebar
2.  Alt + Spacebar
3.  Shift + Spacebar
4.  Spacebar
   
   



READING COMPREHENSION
Section Id : 2549898939
Section Number : 2
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 1
Number of Questions to be attempted : 1
Section Marks : 5
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549898980
Question Shuffling Allowed : No
   



Question Id : 25498921445 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension Questions : No
Question Pattern Type : NonMatrix
Question Numbers : (53 to 57)
Read the given passage and answer the questions that follow.
 
The institution of family has received a fatal blow because of modern lifestyles. In numerous cases, children have moved to big cities with their parents,
while their grandparents continue to live in their native places. This split has created a big void in family life. Where both parents are working, children
come back from school to find the house empty. There is nobody to greet them or serve them hot food. At such times they long for the love and affection of
their grandparents.
Grandparents shower love on young children and make a meaningful contribution to their lives. They have lots of time to share their experiences with the
children and patiently listen to what the children have to say. The wisdom of the old people is real and not bookish. So, they can best teach the children
about the value of hard work, discipline, patience and sacrifice. Children who interact with their grandparents learn quickly and effortlessly.
Grandparents also provide a vital link between generations. They tell children about their various family members and show them family albums, along with
interesting commentaries about the habits of certain aunts and uncles. They keep the children connected with the family even if it is not possible to
physically meet all relatives. Grandparents provide a sense of security to children. They give comfort to children and a feeling of being there for them in
case of any difficulties.
Grandparents keep the family traditions alive. They teach children about the different festivals and special days that are important for each family. They
teach children the proper way of celebrating festivals and doing certain other things.
It is a great blessing to have grandparents living with the grandchildren. They share a special bond of love and care. Their relationship is mutually fulfilling.
Sub questions
 
Question Number : 53 Question Id : 25498921446 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Children living in nuclear families tend to miss their:
Options :
1.  parents' attention
2.  aunts and uncles
3.  grandparents' affection
4.  native place
 
Question Number : 54 Question Id : 25498921447 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
'The wisdom of the old people is real and not bookish’ implies that grandparents got their wisdom:
Options :



1.  from the books they have read in their life
2.  from actual experiences in their life
3.  by following traditions
4.  by memorising their lessons
 
Question Number : 55 Question Id : 25498921448 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
How do grandparents provide a link between generations?
Options :
1.  They arrange for a meeting of all the family members.
2.  They talk about family members and show their pictures.
3.  They insist on all the uncles and aunts staying together.
4.  They often go to meet distant relatives.
 
Question Number : 56 Question Id : 25498921449 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Grandparents provide their grandchildren with a sense of security by:
Options :
1.  teaching them about hard work and discipline
2.  comforting them and being with them during difficult times
3.  greeting them and serving them hot food
4.  teaching them about the importance of special days
 
Question Number : 57 Question Id : 25498921450 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following statements is FALSE as per the given passage?
Options :
1.  Grandparents give their grandchildren love and affection.
2.  Children can be good friends with their grandparents.
3.  Grandparents do not know about the proper way of celebrating festivals.



4.  Children learn about patience and sacrifice from their grandparents.
   



Question Id : 25498921445 Question Type : COMPREHENSION Sub Question Shuffling Allowed : Yes Group Comprehension Questions : No
Question Pattern Type : NonMatrix
Question Numbers : (53 to 57)
दिए गए गद्यांश को पढ़िए और उसके  बाद आने वाले �श्नों के  उ�र दीजिए।

आधुनिक जीवनशैली के  कारण परिवार की संस्था को ब�त आघात पहुंचा है।
कई मामलों में, यह देखा गया है कि बच्चों को अपने माता-पिता के  साथ बड़े शहरों में स्थानांतरित होना पड़ता हैं जबकि उनके  दादा-दादी अपने मूल स्थान पर ही रह जाते हैंI
इस विभाजन के  कारण पारिवारिक जीवन में बड़ी रि�ता उत्‍पन्‍न हो गयी हैI जिस परिवार में माता-पिता दोनों कार्य करते हैं वहां पर बच्चे स्कू ल से वापसी के  समय घर को
सूना पाते हैंI उनका अभिवादन करने वाला और उन्हें गर्म खाना परोसने वाला कोई नहीं  होताI ऐसी स्थिति में वे अपने दादा-दादी के  प्यार और स्नेह के  लिए तरसते हैंI

दादा-दादी बच्चों को ब�त प्यार देते हैं और उनके  जीवन में सार्थक योगदान देते हैं। उनके  पास अपने अनुभवों को बच्चों में साझा करने का ब�त समय होता है और वे
धैर्यपूर्वक उनकी बात सुनते हैं। वृ� लोगों का ज्ञान वा�विक होता है न कि किताबी। इसलिए वे बच्चों को सर्वश्रे� तरीके  से कड़ी मेहनत, अनुशासन, धैर्य और बलिदान के
मू� के  बारे  में सिखा सकते हैं। जो बच्चे अपने दादा-दादी से बातचीत करते हैं वे शी�ता और सरलता से सीखते हैं। दादा-दादी पीढ़ियों के  बीच एक मह�पूर्ण कड़ी �दान
करते हैं। वे बच्चों को अपने परिवार के  विभि� सदस्यों के  बारे  में बताते हैं और उन्हें कु छ चाची और चाचा की आदतों के  बारे  में दिलच� टि�णियां करते �ए पारिवारिक
ए�म दिखाते हैं। वे बच्चों को परिवार से जोड़े रखते हैं, भले ही शारीरिक �प से सभी रिश्तेदारों से मिलना संभव न हो। दादा-दादी बच्चों को सुरक्षा की भावना �दान करते
हैं। वे किसी भी कठिनाई में बच्चों को आराम देते हैं और आ�� करते हैं कि वे वहां उनके  लिए मौजूद हैं।

दादा-दादी परिवार की परंपराओं को जीवित रखते हैं। वे बच्चों को विभि� त्यौहारों और विशेष दिनों के  बारे  में बताते हैं जो �त्येक परिवार के  लिए मह�पूर्ण हैं। वे बच्चों को
त्योहारों को मनाने और कु छ अ� चीजों को करने का उचित तरीका सिखाते हैं। दादा-दादी का बच्चों के  साथ होना एक बड़ा वरदान है। वे प्यार और परवरिश का एक विशेष
बंधन साझा करते हैं। उनका रिश्ता पार�रिक �प से पूर्णता �दान करता है।
Sub questions
 
Question Number : 53 Question Id : 25498921446 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एकल (मूल) परिवारों के  बच्चे किसकी कमी महसूस करते हैं?
Options :
1.  अपने माता-पिता के  ध्यान का
2.  अपने चाची और चाचा का
3.  अपने दादा-दादी के  स्नेह का
4.  अपने मूल स्थान का
 
Question Number : 54 Question Id : 25498921447 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes



Correct Marks : 1 Wrong Marks : 0
वृ� लोगों का ज्ञान वा�विक है किताबी नहीं । इसका मतलब है कि दादा-दादी को अपना ज्ञान ___________ ।
Options :
1.  स्कू लों में पढ़ी गई किताबों से मिला है
2.  वा�विक जीवन के  अनुभव से मिला है
3.  परंपराओं का पालन करके  मिला है
4.  अपने सबक याद करके  मिला है
 
Question Number : 55 Question Id : 25498921448 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
दादा-दादी, पीढ़ियों के  बीच एक कड़ी कै से �दान करते हैं?
Options :
1.  वे परिवार के  सभी सदस्यों की बैठक की �वस्था करते हैं।
2.  वे परिवार के  सदस्यों के  बारे  में बात करते हैं और उनकी तस्वीर दिखाते हैं।
3.  वे एक साथ रहने के  लिए सभी चाचा और चाची पर जोर देते हैं।
4.  वे अ�र दू र रिश्तेदारों से मिलने जाते हैं।
 
Question Number : 56 Question Id : 25498921449 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
दादा-दादी अपने पोते-पोतियों को सुरक्षा की भावना कै से �दान करते हैं?
Options :
1.  उन्हें कड़ी मेहनत और अनुशासन के  बारे  में पढ़ाकर 

2.  उन्हें दिलासा देकर और मुश्किल समय में उनके  साथ रहकर
3.  उनका अभिवादन कर और उन्हें गरमा गरम खाना परोसकर
4.  उन्हें विशेष दिनों के  मह� के  बारे  में पढ़ाकर  
 
Question Number : 57 Question Id : 25498921450 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
दिए गए गद्यांश के  अनुसार नि�लिखित में से कौन सा कथन गलत है?



Options :
1.  दादा-दादी प्यार और स्नेह देते हैं।
2.  दादा-दादी के  साथ बच्चे अच्छे  दो� हो सकते हैं।
3.  दादा-दादी को त्योहार मनाने का सही तरीका नहीं  पता होता है।
4.  बच्चे अपने दादा-दादी से धैर्य और त्याग के  बारे  में सीखते हैं।
   
   

QUANTITATIVE APTITUDE
Section Id : 2549898940
Section Number : 3
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6
Section Marks : 6
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549898981
Question Shuffling Allowed : Yes
   



Question Number : 58 Question Id : 25498928859 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What approximate value should come in place of the question mark (?) in the following equation?
(Note: You are not expected to calculate the exact value.)

1002 ÷ 49 × 99 − 1299 = ?
Options :
1.  700
2.  600
3.  900
4.  250
   
Question Number : 58 Question Id : 25498928859 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
नि�लिखित समीकरण में �� चि� (?) के  स्थान पर लगभग कितना लगभग मान आना चाहिए?
(नोट: आपको शु� मान की गणना करने की आव�कता नहीं  है)

1002 ÷ 49 × 99 − 1299 = ?
Options :
1.  700
2.  600
3.  900
4.  250
   



Question Number : 59 Question Id : 25498929005 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What approximate value should come in place of the question mark (?) in the following equation?
(Note: You are not expected to calculate the exact value.)

Options :
1.  88
2.  44
3.  72
4.  64
   
Question Number : 59 Question Id : 25498929005 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
नि�लिखित समीकरण में �� चि� (?) के  स्थान पर क्या लगभग मान आना चाहिए?
(टि�णीः  आपको शु� मान की गणना करने की आव�कता नहीं  है।)

Options :
1.  88
2.  44
3.  72
4.  64
   



Question Number : 60 Question Id : 25498929042 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In the given question, two equations numbered I and II are given. You have to solve both the equations and mark the appropriate option.

I.    3x2 – 13x + 12 = 0
II.   2y2 – 15y + 28 = 0
Options :

1.  

2.  

3.  

4.  

   



Question Number : 60 Question Id : 25498929042 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
दिए गए �� में, दो समीकरणों को संख्या I और II से चिन्हित किया गया है। दोनों समीकरणों को हल करते �ए उपयु� विक� का चयन करें।

I.    3x2 – 13x + 12 = 0
II.   2y2 – 15y + 28 = 0
Options :

1.  

2.  

3.  

4.  

   
Question Number : 61 Question Id : 25498929146 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
35% of a number is two times 75% of another number. What is the ratio of the first number to the second?
Options :
1.  35 : 6
2.  31 : 7
3.  23 : 7
4.  30 : 7
   



Question Number : 61 Question Id : 25498929146 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एक संख्या का 35% दू सरी संख्या के  75% का दोगुना है। पहली संख्या का दू सरी संख्या से अनुपात ज्ञात करें। 
Options :
1.  35 : 6
2.  31 : 7
3.  23 : 7
4.  30 : 7
   
Question Number : 62 Question Id : 25498929658 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The positive difference between the square of the arithmetic mean of two distinct numbers and the square of their geometric mean is 36. The positive
difference between the arithmetic mean of their squares and the square of their arithmetic mean will be:
Options :
1.  36
2.  24
3.  18
4.  12
   
Question Number : 62 Question Id : 25498929658 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
दो अलग-अलग संख्याओं के  समांतर मा� के  वर्ग और उनके  गुणो�र मा� के  वर्ग के  बीच धना��क अंतर 36 है। उनके  वर्गो के  समांतर मा� और समांतर मा� के  वर्ग के
बीच धना��क अंतर कितना होगा?
Options :
1.  36
2.  24
3.  18
4.  12
   



Question Number : 63 Question Id : 25498929679 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
In an examination, the number of candidates who passed was 4 times the number of those who failed. Had there been 35 candidates less and 9 more had
failed, then the ratio of the numbers of passed and failed candidates would have been 2 : 1. The total number of candidates who appeared in the examination
was:
Options :
1.  155
2.  145
3.  140
4.  135
   
Question Number : 63 Question Id : 25498929679 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एक परीक्षा में उत्तीर्ण होने वाले अ�र्थियों की संख्या, अनुत्तीर्ण होने वाले अ�र्थियों की संख्या से 4 गुना थी। यदि कु ल 35 अ�र्थी कम होते और 9 अ�र्थी अधिक अनुत्तीर्ण
होते, तो उत्तीर्ण और अनुत्तीर्ण अ�र्थियों का अनुपात 2:1 होता। परीक्षा में सम्मिलित होने वाले कु ल अ�र्थियों की संख्या कितनी थी?
Options :
1.  155
2.  145
3.  140
4.  135
   
   

GENERAL MENTAL ABILITY AND REASONING
Section Id : 2549898941
Section Number : 4
Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 6
Number of Questions to be attempted : 6
Section Marks : 6



Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549898982
Question Shuffling Allowed : Yes
   
Question Number : 64 Question Id : 25498910268 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
‘Door’ is related to ‘Bang’ in the same way as ‘Chain’ is related to:
Options :
1.  Thunder
2.  Clinch
3.  Tinkle
4.  Clank
   
Question Number : 64 Question Id : 25498910268 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
दरवाजे (Door)' का 'बैंग (Bang)' से वही संबंध है जो 'चेन (Chain)' का ______ से संबंध है।
Options :
1.  थंडर (Thunder)

2.  क्लिंच (Clinch)

3.  टिंकल (Tinkle)

4.  क्लैंक (Clank)
   



Question Number : 65 Question Id : 25498914063 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Rearrange the below letters to make a meaningful 8-letter word, and select the option that has the last letter in the word.

H D M E I L S O
Options :
1.  M
2.  L
3.  H
4.  S
   
Question Number : 65 Question Id : 25498914063 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
नीचे दिए गए अ�रों को पुनर्व्यवस्थित करके  एक सार्थक 8 अ�र वाला श� बनाएं , और उस विक� का चयन करें  जिसमें श� का अंतिम अ�र हो।

H D M E I L S O
Options :
1.  M
2.  L
3.  H
4.  S
   



Question Number : 66 Question Id : 25498919852 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Six people, D, F, G, K, S and V are sitting in a row facing north. Exactly two people sit to the left of V. G sits to the immediate right of V. S sits second to
the right of G. F sits to the immediate left of D. How many people sit to the left of K?
Options :
1.  None
2.  One
3.  Three
4.  Four
   
Question Number : 66 Question Id : 25498919852 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
छह लोग, D, F, G, K, S और V उ�र की ओर मुंह करके  एक पंक्ति में बैठे  हैं। V के  बाईं ओर ठीक दो लोग बैठे  हैं। G, V के  तुरंत दाईं ओर बैठता है। S, G के  दाईं ओर
दू सरे  स्थान पर बैठता है। F, D के  तुरंत बाईं ओर बैठता है। K के  बाईं ओर कितने लोग बैठते हैं?
Options :
1.  कोई नहीं
2.  एक
3.  तीन
4.  चार
   



Question Number : 67 Question Id : 25498927404 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Identify the figure given in the options which when put in place of the question mark (?) will logically complete the series?

Options :

1.  

2.  



3.  

4.  

   



Question Number : 67 Question Id : 25498927404 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
विकल्पों में दी गई उस आकृ ति को पहचानिए जिसे �� चि� (?) के  स्थान पर रखने पर श्रृंखला तार्कि क �प से पूरी हो जाएगी?

Options :

1.  

2.  



3.  

4.  

   
Question Number : 68 Question Id : 25498928183 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
What should come in place of the question mark (?) in the given series?

17, 28, 39, 50, 61, ?
Options :
1.  72
2.  70
3.  80
4.  75
   



Question Number : 68 Question Id : 25498928183 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
दी गई श्रृंखला में �� चि� (?) के  स्थान पर क्या आना चाहिए?

17, 28, 39, 50, 61, ?
Options :
1.  72
2.  70
3.  80
4.  75
   
Question Number : 69 Question Id : 25498928703 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Four letter-clusters have been given below. Based on the English Alphabetical order, three are alike in some manner and one is different. Select the one that
is different.
Options :
1.  XZCG
2.  OQTX
3.  IMNQ
4.  EGJN
   
Question Number : 69 Question Id : 25498928703 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
नीचे चार अ�र-समूह दिए गए हैं। अंग्रेजी वर्णमाला �म के  आधार पर, तीन किसी तरह से समान हैं और एक असंगत है। उस असंगत अ�र-समूह का चयन कीजिए।
Options :
1.  XZCG
2.  OQTX
3.  IMNQ
4.  EGJN
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Number of Questions to be attempted : 6
Section Marks : 6
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Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549898983
Question Shuffling Allowed : Yes
   
Question Number : 70 Question Id : 2549895395 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Haldia refinery is located in:
Options :
1.  West Bengal
2.  Bihar
3.  Andhra Pradesh
4.  Odisha
   



Question Number : 70 Question Id : 2549895395 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
हल्दिया रिफाइनरी कहाँ स्थित है?
Options :
1.  पश्चिम बंगाल
2.  बिहार
3.  आं� �देश
4.  ओडिशा
   
Question Number : 71 Question Id : 25498912799 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Which of the following is NOT a football club?
Options :
1.  Arsenal
2.  Aston Villa
3.  Chelsea
4.  McLaren
   
Question Number : 71 Question Id : 25498912799 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
नि� में से कौन-सा, एक फ़ु टबॉल �ब नहीं  है?
Options :
1.  आर्सेनल (Arsenal)

2.  एस्टॉन विला (Aston Villa)

3.  चेल्सी (Chelsea)

4.  मैकलारेन (McLaren)
   



Question Number : 72 Question Id : 25498932060 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Pandit Shiv Kumar Sharma is an exponent of:
Options :
1.  mandolin
2.  santoor
3.  sitar
4.  veena
   
Question Number : 72 Question Id : 25498932060 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
पंडित शिव कु मार शर्मा किसके  �तिपादक (exponent) हैं?
Options :
1.  मैन्डोलिन
2.  संतूर
3.  सितार
4.  वीणा
   
Question Number : 73 Question Id : 25498935450 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Devaluation usually causes the internal prices to:
Options :
1.  fall
2.  rise
3.  remain unchanged
4.  fluctuate
   



Question Number : 73 Question Id : 25498935450 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
अवमू�न के  कारण प्रायः  आंतरिक कीमतों पर क्या �भाव होता है?
Options :
1.  इसमें गिरावट होती है।
2.  इसमें वृद्धि होती है।
3.  यह अपरिवर्तित रहती है।
4.  इसमें उतार- चढ़ाव होता रहता है।
   
Question Number : 74 Question Id : 25498935648 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
The diameter of a colloidal particle ranges from:
Options :
1.  10-9 m to 10-6 m

2.  10-6 m to 10-3 m

3.  10-12 m to 10-9 m

4.  10-3 m to 10-6 m
   
Question Number : 74 Question Id : 25498935648 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
एक कोलॉइडी कण का व्यास किस परास (रेंज) में होता है?
Options :

1.  10-9 m से 10-6 m

2.  10-6 m से 10-3 m

3.  10-12 m से 10-9 m

4.  10-3 m से 10-6 m
   



Question Number : 75 Question Id : 25498935695 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
Vote on account is the permission to ___________, usually two months.
Options :
1.  go for public loan
2.  borrow money from the Reserve Bank of India
3.  give grants in aid to states
4.  withdraw money from consolidated fund of India
   
Question Number : 75 Question Id : 25498935695 Question Type : MCQ Option Shuffling : Yes Display Question Number : Yes
Correct Marks : 1 Wrong Marks : 0
वोट ऑन अकाउंट (Vote on account) ___________ की अनुमति है, जो आमतौर पर दो महीने तक होती है।
Options :
1.  सार्वजनिक ऋण प्रा� करने
2.  भारतीय रिजर्व बैंक से धन ऋण लेने
3.  राज्यों को अनुदान सहायता देने
4.  भारत की समेकित निधि से धन आहरित करने
   
   

English Mock
Group Number : 2
Group Id : 2549895573
Group Maximum Duration : 5
Group Minimum Duration : 5
Show Attended Group? : No
Edit Attended Group? : No
Break time : 1
Mandatory Break time : Yes
Group Marks : 0
   



   

English Mock
Section Id : 2549898943
Section Number : 1
Section type : Typing Test
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Number of Questions : 1
Number of Questions to be attempted : 1
Section Marks : 0
Display Number Panel : Yes
Maximum Instruction Time : 0
Sub-Section Number : 1
Sub-Section Id : 2549898984
Question Shuffling Allowed : No
Is Section Default? : Yes
   
Question Number : 76 Question Id : 25498946188 Question Type : TYPING TEST Display Question Number : Yes Calculator : None
Summer camps are supervised camps conducted to entertain as well as equip students with various life skills such as teamwork, socializing,
decision making, independent and responsible living and more. It aids the overall development of a child and children have fun during this process
as they get to explore new arenas.
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Question Number : 77 Question Id : 25498942568 Question Type : TYPING TEST Display Question Number : Yes Calculator : None
A search engine is a tool used to find data based on a particular input. Web search engines are one example where you can enter a word or phrase
to find web pages that match those terms. Not every web search engine works the same way. Most of them are crawler based. It means that they
actively seek the web for pages to add to their index. The search engine is what you use to quickly lookup information from the index and display
the results on the page. Search engines are the primary method for browsing the web and there are many different kinds that are built for finding
specific information. Within each search engine are often advanced search options that are used to focus your search better and help you find what
you're looking for. Search engines automatically create website listings by using software often called spiders or spiderbots. These spiderbots crawl
web pages. They follow a link of site to other pages and index the information in the process. The crawler bots behind the search engine scour the
web not only by jumping from one link to the next but also by checking each site for a robots text file. This file contains a listing of which pages on
the site a search engine should crawl. This is one way website owners can block a search engine from indexing a particular page. Software spiders
return to pages that have already been crawled on a pretty regular basis to check for updates and changes. Everything they find goes back into the
search engine database. Every search engine is different. But the common idea with all of them is to type something into a search box and wait for
the results. Some search engines also have a reverse search option that lets you browse the web with something other than text. They can search a
sound clip or picture file. Many search engines include extra features beyond just a simple search box. They let you interact with the index using
special text commands or buttons that can filter the results and remove items that are not relevant to what you are looking for. Lots of search
engines exist and the one you choose to use should depend on what you want to do with it. Web page search engine are often multi purposed. They
locate all sorts of data from general web pages and news to help documents. Image search engines search for photos and drawings. Video search
engines find all kinds of videos and live streams. People search engines locate people on the internet using their name and address. A regular search
engine that's optimized for searching and displaying results on a smaller screen are called mobile search engines. Job search engines are designed
to find job postings. Invisible web search engines are the tools that browse the invisible web. There is no need to manually update a search engine so
that you are getting the most updated results in your searches. If you are seeing really old results that you suspect should be updated. But actually
you might just need to clear the cache of browser. Search engines do not search the entire web. There are portions of the web that are not crawlable
by a search engine.
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Question Number : 78 Question Id : 25498946199 Question Type : TYPING TEST Display Question Number : Yes Calculator : None
एक बार की बात है, अकबर और बीरबल शिकार पर जा रहे थे। अभी कु छ समय की उन्हें एक हिरण दिखा। ज�बाजी में तीर निकालते �ए अकबर अपने हाथ
पर घाव लगा बैठा। अब हालात कु छ ऐसे थे की अकबर ब�त दर्द में था और गुस्से में भी।
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Question Number : 79 Question Id : 25498944411 Question Type : TYPING TEST Display Question Number : Yes Calculator : None
परोपकार यानी दू सरो का भला करना। पर और उपकार को जोडकर परोपकार बनता है। यह दो पदों  को मिलाकर परोपकार बनता है। इंसानियत और मानवता
की भावना परोपकार कहलाता है। इंसान एक समाजिक प्राणी है। जब किसी को मदद की ज�रत होती है और कोई भला इंसान उसकी सही समय पर मदद
करता है उसे परोपकार कहते है। परोपकारी इंसान बिना किसी लोभ के  दू सरे  लोगो की सेवा अथवा सहायता करता है। उसके  मन में सबके  �ति प्रेम भावना
रहती है। वह किसी भी आदमी को परेशानी में नहीं  देख सकता है। परोपकार इंसान समाज में प्रेम संदेश और भाईचारा फै लाता है। एक इंसान तभी एक बढिया
इंसान कहलाता है जब वह दू सरो का भला करता है। दुनिया में भी सूरज गरमी और �काश धरती को देता है। इसकी वजह से हम सब प्राणी जिंदा है। आसमान
में छाये बादल धरती पर बारिश करते है। इससे सभी प्राणियों  को जल मिलता है। परोपकार की भावना लोगो में भाईचारे  को बढावा देती है। किसी का भला करने
से मन को जो शांति मिलती है उसे बयान नहीं  किया जा सकता है। परोपकार करने से इंसान के  मन को खुशी मिलती है। किसी गरीब आदमी के  बेटे की शिक्षा
के  लिए मदद करना या तेज धूप और गरमी में पिपासित को ठं डा पानी पिलाना परोपकार है। इंसान के  �प में हम पैदा इसलिए होते है ताकि हम समाज में लोगो
की सहायता कर सके । हमे सैदव यह कोशिश करनी चाहिए कि हमारे  दरवाजे पर अगर कोई इंसान किसी मुसीबत में हो तो जितना हमसे हो सके  हम उसकी
मदद करें। दान देने के  लिए धनवान होने की ज�रत नहीं  होती है के वल उसकी नीयत ही काफी होती है। ब�त से लोग भोजन और कपडे और दवाईयां आदि
का दान करते है। यह परोपकार कहलाता है। सबका भला करने से मन में नफरत कम हो जाती है। समाज में झगडे कम हो जायंगे। इंसान के वल ज�रतमंद
लोगो का नहीं  पशुओं की भी देखभाल करते हैं। मानवता ही परोपकार है। जिस इंसान में मानवता की भावना नहीं  है वह इंसान कहलाने काबिल नहीं  है।
मानवता की भावना इंसान को सभी प्राणियों  से अलग बनाती है। परोपकार करने के  कई तरीके  है। किसी गरीब की सहायता करना और उसे काम पर रखना
तथा रोजगार देना और भोजन देना आदि सभी परोपकार है। कोई रोगी अपना इलाज नही करा पाते है और उसकी मदद करना ही परोपकार है। लोगो को
हमेशा दू सरो के  �ति सहानभूति और दयाभाव रखना चाहिए तभी एक बढिया समाज बन पाता है। किसी भी ज�रतमंद आदमी को संकट में पाकर उसकी तुरंत
मदद करनी चाहिए। एक परोपकारी इंसान का काम है। यदि कोई गलत पथ पर चल रहा है तो उसे सही राह दिखाना परोपकारी इंसान का काम है। किसी भी
परेशान आदमी के  दुख का बांटना और उसका साथ देना और उसे समझाना आदि परोपकार के  अलग अलग �प है। मानव को अपने समाज में �गति लाने के
लिए परोपकार की ज�रत है। समाज में रह रहे सभी लोगो को एक दू सरे  के  �ति दयाभाव रखना चाहिए। समाज में लोगो को एक दू सरे  की चिंता करनी होगी
तभी एक बढिया और संवेदनशील समाज का गठन हो पायेगा। हमेशा समाज में लोगो को नेक काम करने हों गे तभी एक कु लीन समाज बनेगा। इंसान को
जिंदगी में बढिया काम करने चाहिए। बढिया काम और परोपकार की भावना लोगो को बढिया इंसान बनाती है।
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